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INTRODUCTION 

 
FastTerrain is a software utility which can be used in order to build, edit and project in 3D 
space Digital Terrain Models (DTMs). The terrain model is produced by using a set of 3D 
points and break-lines.  

 

 
 

 
Insert entities from AutoCAD (using MS ActiveX).   FastTerrain is able to read the following 
data from AutoCAD: 

i) The terrain points. 
ii) The terrain break-lines. 
iii) The subtraction boundary (a boundary 2d poly-line needed when you subtract two 

terrain models).  
iv) The excavation poly-line (a 2d poly-line defining the foundation level).  
 

In many cases this operation helps the designer and simplifies the terrain model creation.  You 
can insert the above data as described below:  
 

• Τhe AutoCAD must be running on your desktop and the desirable DWG file 
should be selected before you execute the command in FastTerrain. 

 

• After the execution of the command in FastTerrain, you must go to AutoCAD. 
When you go to AutoCAD, the prompt in the command line is “select objects” and 
the mouse cursor is a small square. Select the entities and then press the right 
mouse button or the Enter key to complete the command. 
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FILE MENU 
 
The File menu includes the following commands:  

 
New file: Creates a new *.FTF file. 
 
Open: Open an existing *.FTF file. 
 

Save: Saves the current *.FTF file. When you execute this command for the first time in a new 
project, the program will prompt you to insert a name for the new created FTF file.  
 

You can call the above commands by clicking the below icons.  
 

 
 
Save as: Saves the current *.FTF file with a new name.  
 

Close: Closes the current opened file.  
 

Import: With these commands you can create the terrain model by using data contained into 
DXF or ascii files.  
 

DXF file�: By executing this command the program shows a dialog in which you 
can choose the file to be inserted. When you open the selected file the program 
shows the DXF file import dialog box. 
 

 
 

Set as background:   
If you choose this option the program will set all the lines, polylines and texts 
contained in the selected DXF file as background drawing of the current 
project.  
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Points layer: 
In this list, you can select the layer (of the DXF file) that contains the points 
from which the terrain model will be calculated. If you choose the ALL option 
the program will calculate the terrain model from all points contained in all 
layers of the DXF file. 
 
Constrained triangulation: 
This option enables the calculation of the terrain model using breaklines 
(constrained triangulation). If you check this option, the program enables the 
Breaklines layer list in which you can select the layer that contains the 
breaklines.  

 
Breaklines layer: 
 In this list, you can choose the layer (of the DXF file) that contains the 
breaklines which will be used during the computation of the terrain model. The 
breaklines can be only 3d lines or polylines (3d polylines, 2d polylines etc.). 
These lines are taken into the calculation if the poly-line points are identified 
with points of Points layer.  
 
Min points elevation:  
The minimum valid elevation for the inserted entities. Entities points having 
elevation values lower than the Min points elevation value are ignored during 
the computation of the terrain model. 
[Value type: decimal number,  Value range: -∞<value<+∞, unit: m] 

 
Max  points elevation:   
The maximum valid elevation for the inserted entities. Entities points having 
elevation values higher than the Max points elevation value are ignored during 
the computation of the terrain model. 
[Value type: decimal number,  Value range: -∞<value<+∞, unit: m] 

 
Max length of TIN edges:  
This field defines the maximum allowable length for the edges of the terrain 
model.  
[Value type: decimal number,  Value range:0<=value<+∞, unit: m] 

 
Add to existing model: 
If you have this option enabled the program will add the current inserted data 
to the existing model. 
 

ASCII file�: By executing this command the program shows a dialog in which you 
can choose the file to be inserted. When you open the selected file the program 
shows the ASCII file import dialog box. 
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File has a header: 
If you choose this option the program ignores the first line of the file. Usually 
the first line includes general information about the file data. 

 
Field seperator: 
In this drop down list you can select the field separator character. 
 
Code: 
This column includes the identifier of each point. 
[Value type: String] 

 
Easting (X): 
This column includes the X coordinate of each point. 
[Value type: decimal number,  Value range: -∞<value<+∞, unit: m] 

 
Northing (Y): 
This column includes the Y coordinate of each point. 
[Value type: decimal number,  Value range: -∞<value<+∞, unit: m] 

 
Elevation (Z): 
This column includes the Z coordinate of each point. 
[Value type: decimal number,  Value range: -∞<value<+∞, unit: m] 

 
Description: 
This column includes an optional description for each point. 
[Value type: String] 

 
Min points elevation:  
The minimum valid elevation for the inserted entities. Entities points having 
elevation values lower than the Min points elevation value are ignored during 
the computation of the terrain model. 
[Value type: decimal number,  Value range: -∞<value<+∞, unit: m] 

 
Max  points elevation:   
The maximum valid elevation for the inserted entities. Entities points having 
elevation values higher than the Max points elevation value are ignored during 
the computation of the terrain model. 
[Value type: decimal number,  Value range: -∞<value<+∞, unit: m] 
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Max length of TIN edges:  
This field defines the maximum allowable length for the edges of the terrain 
model.  
[Value type: decimal number,  Value range:0<=value<+∞, unit: m] 

 
Add to existing model: 
If you have this option enabled the program will add the current inserted data 
to the existing model. 

 

 

Create XYZ file�: With this command, you can create a XYZ file from the points stored in the 

program’s database. The point coordinates, in these files, with space characters are 
separated.  
 
Create volume file: If you execute this command, the program creates an ascii (text) file 
containing the report of the volume calculation. When the program builds the terrain model, 
computes the volumes between the terrain surface and the XY plane.  

 
Create subtraction report: If you execute this command, the program creates an ascii (text) 
file containing the report of the subtraction result between two terrain models.  
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VIEW MENU 
 

The View menu includes the following commands:  
 

Zoom Extents,  Zoom Previous,  Zoom Rect,  Realtime pan,  Zoom In,  Zoom Out: 
In all CAD design programs these commands are common. In DIOLKOS these commands 
have the same functionality. 
 
Zoom Extents:  
Zooms to display the drawing extents. With this command the plan window is adapted to the 
limits of horizontal alignment. 
 
Zoom Previous:  
Zooms to display the previous view.  
 
Zoom Rect:  
Zooms to display an area specified by two opposite corners of a rectangular window.  
 
Realtime pan:  
By selecting this command, you lock the cursor to its current location relative to the viewport 
coordinate system. The drawing display is moved to the same direction as the cursor. 
 
Zoom In:   
This command magnifies the view 
 

Zoom Out:   
This command miniaturizes the view 
 
Orbit camera:   
Activate a 3D Free Orbit view in the current viewport. The camera location, or point of view, 
moves around the target. The center of the arcball, not the center of the objects you’re 

viewing, is the target point. By pressing the Esc key or the  button you can exit from the 
orbit state. 
 

Layers:   
If you execute this command the program shows the Layers dialog box. 
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By using this form you can handle the entities appearance in the program’s window. The 
coloured squares next to the layers names define the colour of each layer. By clicking on this 
square you can change its colour. By checking the Shade option, you can see the terrain 
model shaded in 3d space. In this way you can easily find errors on the terrain model 
geometry (e.g. points with invalid elevation, invalid break-lines etc.). Finally, if the Faces option 
is selected, the program draws the edges of all 3d faces. 
 

Layers: Within this frame you can control and handle the layers included in the 
current project.  
 

Layer name: This column contains the name of each layer. 
  
Visible: This column controls the visible state of each layer 
 

Color: This column controls the color of each layer 
 

Current layer: In this field the program shows the current layer. 
 

New: By pressing this button the program creates a new layer. The name of 
the new created layer is given automatically. 
 
Delete: By pressing this button the program will delete the current selected 
layer. 
 
Set current: By pressing this button the program sets the current layer. 
 

 

 

You can call the above commands by clicking the below icons.  
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INSERT MENU 

 
The Insert menu includes the following commands:  
 
Point:  
With this command you can import a point into the current terrain model. The elevation of the 
newly inserted point is taken from the elevation of the current terrain model in the specific 
position. 
 
Island point:  
With this command you can insert an island point. When you insert an island point within a 
region limited with break-lines  then the program erase all the triangles included in this area. 
 
When you insert an island point inside the closed region< 

 

 
 
The result is< 
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When the island point is outside from the closed region< 

 

 
 
The result is< 

 

 
 

 

Break-line:  
With this command you can insert a break-line into the current terrain model. When you 
execute this command the program enables the snap to the points function. 

 
Background line:  
With this command you can insert a background line into the current project. When you 
execute this command the program enables the snap to the points function. 

 
Subtraction boundary:  
With this command you can insert the subtraction boundary. The subtraction boundary defines 
the area in which the subtraction between two terrain models will be computed.  
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Excavation poly-line:  
With this command you can insert the excavation poly-line. The excavation poly-line defines 
the foundation level of the excavation bed. This poly-line must be closed. After entering the 
last point the program shows an input box asking for the foundation elevation.  

 
From AutoCAD:  
As mentioned in the introduction you can import the above objects directly from AutoCAD. 

 
The FastTerrain is able to read directly from AutoCAD: 

i) The terrain points (as 3d points). 
ii) The terrain break-lines (as 3d lines). 
iii) The subtraction boundary (as poly-line). 
iv) The excavation foundation (the foundation level is defined by the elevation 

property of the poly-line).  
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EDIT MENU 
 

The Edit menu includes the following commands:  
 
Undo:  
Undo the last operation. 
  
Redo:  
Reverses the effects of previous Undo command. 
 
Parameters�:  
When you execute this command the program shows the Parameters dialog box. 
 

General tab:  
 

 
 

Min points distance:  
If two or more points have distance between them less than the value defined 
in this field the program keeps only the first of these points. 
[Value type: decimal number,  Value range: 0<value<+∞, unit: m] 

 
Distance between contours text:  
With this field you can define the maximum distance (on contour’s curve) 
between the contour texts. This value has effect both in the program’s window 
and in the contours drawing.  
[Value type: decimal number,  Value range: 0<value<+∞, unit: m] 

 
Show contours text:  
If you enable this option the program shows the contour texts both in the 
program’s window and in the contours drawing.  
 
The last two commands are in effect every time you execute the Create 
contours1 command (see below).  
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Drawings tab:  
 

   This tab includes fields controlling the creation of the relative drawings.  
 

 
 

Basic contours per (number of contours):  
In this field you can define per which number of contours will have main 
contours. 
[Value type: integer  number,  Value range: 0<value<+∞, unit: number] 

 
Min distance between points:  
In this field you can define the minimum distance between two contour points.  
[Value type: decimal number,  Value range: 0<value<+∞, unit: m] 

 
Scale factor (Contours):  
In this field you can define scale factor for the contours drawing.  
[Value type: decimal number,  Value range: 0<value<+∞, unit: m] 

 
2D points:  
If you check this option the program creates the points drawing only with X 
and Y coordinates.  

 
3D points:  
If you check this option the program creates the points drawing with X, Y and 
Z coordinates.  

 
Points elevation:  
If you check this option the program will add the elevation text near to the 
point object.  
 

Points code:  
If you check this option the program will add the code text near to the point 
object.  
 

Scale factor (Points):  
In this field you can define scale factor for the points drawing.  
[Value type: decimal number,  Value range: 0<value<+∞, unit: m] 
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Drawings output: 
In this drop down list you can select the output target for the produced 
drawings. You can extract the drawings directly to AutoCAD (by using ActiveX 
automation technology) or you can save them into DXF files. If you extract the 
drawings as DXF files then you can open and edit them by using any DXF 
compatible program.  

 
3D tab:  

 

 

 

With this dropdown list, you can choose the direction for the lighting source in 
the program’s window. The shading result of the terrain model depends on the 
active direction of the lighting source.  
 

Points array�:  
When you execute this command the program shows the Points array dialog box.  
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Points code:  
This column contains the code of each point. 
[Value type: string] 

 
X:  
This column contains X-coordinate of each point. 
[Value type: decimal number,  Value range: -∞<=value<+∞, unit: m] 

 
Y:  
This column contains Y-coordinate of each point. 
[Value type: decimal number,  Value range: -∞<=value<+∞, unit: m] 

 
Z:  
This column contains Z-coordinate of each point. 
[Value type: decimal number,  Value range: -∞<=value<+∞, unit: m] 

 
Desc:  
This column contains the description of each point. 
[Value type: string] 

 
Reset model:  
If you execute this command the program will return back to initial terrain model ignoring the 
flipped edges and deleted faces. 

 
Create contours�:  
This command creates the contours of the current terrain model. When you execute this 
command the program shows an input box asking for the contours DZ interval. 

 
Delete faces�:  
When you execute this command the program shows an input box asking you to insert the 
maximum edge length for the 3d faces. This command erases any face having edge with 
length greater than the previous inserted value.  

 
Flip edge:  
With this command you can flip the common edge between two neighbour triangles. When 
you execute this command the program change the cursor appearance and expect to select 
the two triangles. 

 
Move point:  
With this command you can move a terrain point on a new position. When you execute this 
command the program change the cursor appearance and expect to select a point. 

 
Delete object:  
This command group contains ‘erase’ commands for the following objects: Point, 3D Face, 
Break-line, Background line, Island point.  

 



                                                                                          

 

  16 

Points array�:  
When you execute this command the program shows the Points array dialog box.  

 

 
 
In the Select the Breaklines Layers  listbox you can select the layers containing the breaklines.  

 
Compute excavation diagram:  
When you execute this command the program will compute the excavation diagram by using 
the previous inserted excavation poly-line.  
 

Note: 
Before you execute this command you must define the excavation poly-line. The program 
computes the excavation diagram and the corresponding quantities based on the excavation 
poly-line. This poly-line defines the foundation level and the boundary of the excavation.  
 

 
Terrain subtraction:  
When you execute this command the program shows a dialog box containing the names of all 
opened terrain models. From this list box you can select which model will be subtracted from 
the current active terrain model. 
 

Note: 
Before you execute this command you must define the subtraction boundary poly-line. The 
program computes the subtraction result and the corresponding quantities based on the 
subtraction boundary poly-line. This poly-line defines the area in which the subtraction will be 
executed.  
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DRAWINGS MENU 
 

The Drawings menu includes the following commands:  
 
3D faces:  
This command produces the drawing containing all the 3D faces of the terrain model. 
  
3D Polylines:  
This command produces the drawing containing all the 3D faces edges of the terrain model. 
The edges of the each face forms a 3d poly-line. 
 

3D Lines:  
This command produces the drawing containing all the 3D faces edges of the terrain model. 
The edges of each face are 3d lines. 
 

Points:  
This command produces the drawing containing all the points of the terrain model. The 
program draws the points according the options of the Drawings tab of the Parameters form. 
 

Background:  
This command produces the background drawing. 
 

Contours:  
This command produces the contours drawing of the terrain model. The program draws the 
contours according the options of the Drawings tab of the Parameters form. 
 

Note: 
Before you execute this command you must compute the contour lines first by executing  
Edit->Create contours1 command.  
 

 
Excavation diagram:  
This command produces the excavation diagram. 
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TOOLS MENU 
 

The Tools menu includes the following commands:  
 
Contours TIN:  
With this command you can produce the terrain model from contour lines. The program uses 
a very complicated algorithm to remove the flat triangles. This algorithm performs the 
optimization in two steps. First, extracts the drainage network and the divide lines from the 
contours and after that inserts all these objects as break-lines in the model. The resulting 
terrain model is smooth without flat triangles. 
 

Contours from DXF:  
If you execute this command the program shows the file selection dialog box in 
which you can choose the source DXF file containing the contour lines.  
 

Optimize TIN:  
If you execute this command the program will remove all the flat triangles from the 
terrain model by using the previous described algorithm. 
 

  

 
TERRAINS MENU 

 
The Terrains menu contains all the opened terrain models in the program. The current terrain 
model is marked with the check symbol left from the model’s name. 

 
 

INFO MENU 
 

The Info menu includes the following commands:  
 
Statistics: If you execute this command, the program shows a form containing a brief report of 
the terrain model computation.  The form includes information about: 
 

 

 

Α)  The number of points 
Β)  The number of 3d faces 
Γ)  The number of  break-lines 
∆)  The area of the terrain model 
Ε)  The average grade of the terrain model 
ΣΤ)  The average elevation of the terrain model. 
Ζ)  The volume between the terrain model and the XY plane. 
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Subtraction report: If you execute this command, the program shows a form containing a 
brief report of the subtraction operation. 
 

 

 

 

Help: This command shows the help file of the program. 
 
About: This command shows a dialog box containing information about the version and 
copyrights of the program 
 


